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Πρόλογος 
 

Το SPICE είναι ένα πρόγραμμα εξομοίωσης ηλεκτρονικών κυκλωμάτων στον 

υπολογιστή, με το οποίο παρέχεται η δυνατότητα παρατήρησης των τάσεων και των 

ρευμάτων διαφόρων κόμβων. Πρόκειται, ουσιαστικά, για ένα εργαλείο που καθιστά 

δυνατή την εύκολη εκμάθηση των ηλεκτρονικών κυκλωμάτων, επιτρέποντας στον 

χρήστη να τα τροποποιεί με απλό τρόπο και να αναλύει τόσο τα χαρακτηριστικά, όσο 

και τις συμπεριφορές τους.  

Το πλεονέκτημα του προγράμματος SPICE είναι ότι αποτελεί ένα εικονικό 

breadboard, το οποίο δύναται να λάβει χώρα σε οποιονδήποτε υπολογιστή. 

Πρόκειται, επόμενα, για μία γρήγορη και οικονομική λύση υλοποίησης ηλεκτρονικών 

κυκλωμάτων, εάν υπολογίσει κανείς ότι στην περίπτωση πραγματικής υλοποίησης 

τους απαιτείται αφ’ ενός χρόνος για την τοποθέτηση των αναγκαίων στοιχείων και 

των καλωδιώσεων και αφ’ ετέρου χρήμα, λόγω της επιτακτικής χρήσης των 

breadboards, των ηλεκτρικών στοιχείων, των παλμογράφων και των πηγών τάσεων, 

που αδιαμφισβήτητα αποτελούν έναν πολύ ακριβό εξοπλισμό.  

Επιπλέον, με την χρήση του PSPICE, έχετε τη δυνατότητα να δημιουργήσετε 

το κύκλωμα της αρεσκείας σας, να το αναλύσετε και με βάση τα αποτελέσματα της 

συμπεριφοράς του να το βελτιώσετε. Ως αποτέλεσμα αυτού είναι ο σχεδιασμός του 

κυκλώματος να πραγματοποιείται σύμφωνα με τα εκάστοτε επιθυμητά χαρακτη-

ριστικά. 

Το εγχειρίδιο που διαθέτετε αυτή τη στιγμή στη κατοχή σας και το οποίο θα 

σας εισάγει στο κόσμο του SPICE, διευκολύνοντας στην κατανόηση του, δεν θα είχε 

υλοποιηθεί χωρίς την πολύτιμη βοήθεια του επίκουρου καθηγητή κ. Θεμιστοκλή 

Χανιωτάκη, στον οποίο και οφείλουμε θερμές ευχαριστίες. Ιδιαίτερα τον 

ευχαριστούμε για την δυνατότητα που μας παρείχε ως προς την ενασχόληση με το 

ενδιαφέρον αυτό αντικείμενο, καθώς και για τη διαρκή συνεργασία του. 

Επίσης, θα θέλαμε να ευχαριστήσουμε θερμά τον καθηγητή κ. Δημήτριο 

Νικολό, που προέτρεψε την παρούσα συνεργασία, επιδεικνύοντας αμέριστη 

εμπιστοσύνη στο πρόσωπό μας.  

Ιδιαίτερες ευχαριστίες οφείλουμε στην υποψήφια διδάκτορα κ. Πασσά 

Καλλιόπη-Σοφία, για τις εύστοχες υποδείξεις της στη συντακτική επιμέλεια του 

παρόντος εργαστηριακού εγχειριδίου. 

                                                                                                         Εκ των συγγραφέων
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1. Ιστορική αναδρομή 
 
 Ο simulator SPICE είναι ένα πρόγραμμα εξομοίωσης που η λειτουργία του 

έλαβε χώρα πριν από σαράντα περίπου χρόνια. Στα μέσα της δεκαετίας του ‘60 η 

IBM ανέπτυξε το πρόγραμμα ECAP, το οποίο αρκετά αργότερα χρησιμοποιήθηκε ως 

σημείο αναφοράς από το πανεπιστήμιο του Berkeley για την ανάπτυξη του προγράμ-

ματος CANCER. Μέχρι τις αρχές της δεκαετίας του ‘70 δεν υπήρχαν εργαλεία για 

την αυτόματη ανάλυση των ηλεκτρονικών κυκλωμάτων, γεγονός που είχε ως 

επακόλουθο κάθε τέτοια διαδικασία να εφαρμόζεται σχεδόν εξ’ ολοκλήρου από το 

ανθρώπινο δυναμικό, παρ’ ότι η πολυπλοκότητα τους αυξανόταν ολοένα και περισ-

σότερο. Η διαρκής εξέλιξη, λοιπόν, των ηλεκτρονικών κυκλωμάτων έδωσε το 

έναυσμα σε μια ομάδα του πανεπιστημίου του Berkeley να αναπτύξει την πρώτη 

έκδοση του SPICE (Simulation Program with Integrated Circuits Emphasis), με βάση 

το πρόγραμμα CANCER. Ουσιαστικά, δημιούργησε έναν simulator γενικού σκοπού, 

ο οποίος επέτρεπε την ανάλυση αναλογικών κυκλωμάτων δίχως την ανάγκη της 

κατασκευής τους. 

 Στο SPICE, το κύκλωμα και η εκάστοτε απαιτούμενη ανάλυση βρίσκονται σε 

ένα κείμενο μαζί με δηλώσεις και εντολές. Το κείμενο αυτό διαβάζεται από το SPICE 

και έχοντας ως προϋπόθεση ότι δεν υπάρχουν λάθη στις δηλώσεις, στις εντολές και 

στην σύνδεση του κυκλώματος, δημιουργεί την εξομοίωση. 

 Η επιτυχία του προγράμματος αυτού οφείλεται στην γενικότητα που παρείχε, 

οδηγώντας σταδιακά στην δημιουργία μιας σειράς από εκδόσεις του SPICE. Το 1984 

κατασκευάστηκε από την MicroSim Corporation η πρώτη έκδοση για προσωπικούς 

υπολογιστές, το PSPICE. Οι εκδόσεις του PSPICE με την πάροδο των χρόνων 

ανανεώνονταν διαρκώς, έχοντας φτάσει σήμερα στην έκδοση 9.x. 

 Το SPICE, όντας, πλέον, ένα από τα κυριότερα εργαλεία εξομοίωσης των 

ηλεκτρονικών κυκλωμάτων, αποτελεί αναφορά και βάση για πλήθος προγραμμάτων 

ανάλογων εφαρμογών που κυκλοφορούν. 
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2. Εισαγωγή 

 
 Το πρόγραμμα Orcad PSpice A/D 9.1 student version διατίθεται δωρεάν, και 

μπορεί ο καθένας να το βρει στο internet. (π.χ. στη διεύθυνση http://www.electronics-

lab.com/downloads/schematic/013 ) Ξεκινώντας, ο χρήστης εγκαθιστά το πρόγραμμα 

Orcad PSpice A/D στον υπολογιστή. Ακολούθως, βρίσκεται σε θέση να το 

χρησιμοποιήσει, επιλέγοντας από το μενού Έναρξη > Pspice Student > Pspice Design 

Manager, όπως διακρίνεται στην Εικόνα 1: 

 

 
Εικόνα 1: Ξεκινώντας το PSpice. 

 

 Εν συνεχεία, εμφανίζεται το παράθυρο Design Manager (Εικόνα 2), το οποίο 

επιτρέπει την είσοδο στο schematics για την εισαγωγή και εξομοίωση κυκλωμάτων.  
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Εικόνα 2: Παράθυρο Design Manager. 

  

 Για την εισαγωγή ενός κυκλώματος πρέπει να γίνει έναρξη του προγράμματος 

για schematic capture, PSpice Schematics. Αυτό πραγματοποιείται κάνοντας 

αριστερό κλικ στο κίτρινο εικονίδιο με το κόκκινο μολύβι, που σχεδιάζει ένα 

κύκλωμα, το οποίο βρίσκεται στην αριστερή πλευρά του Design Manager. Η επιλογή 

του εικονιδίου οδηγεί στην εμφάνιση του ακόλουθου παραθύρου: 

 

 
Εικόνα 3: PSpice Schematics. 
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 Το παράθυρο της Εικόνας 3 είναι το σύνηθες παράθυρο που εμφανίζεται για 

την σχεδίαση ενός ηλεκτρικού κυκλώματος. Σημειώνεται ότι, δίδεται η δυνατότητα 

μεγέθυνσης και σμίκρυνσης μέσω της επιλογής view ή με τις συντομεύσεις CTRL+I 

για zoom in και CTRL-O για zoom out. Προκειμένου να πραγματοποιηθούν οι 

διαδικασίες μεγέθυνσης και σμίκρυνσης πρέπει να γίνει αριστερό κλικ στο επιθυμητό 

σημείο του σχεδίου. 

 Η χρήση του προγράμματος Schematics αποτελεί, ουσιαστικά, μια διεπαφή 

για τον χρήστη, η οποία αποσκοπεί στην παροχή μίας εύκολης υλοποίησης 

κυκλωμάτων. Τα κυκλώματα αυτά μετατρέπονται, μέσω του PSpice, σε μια μορφή 

που ονομάζεται Netlist και μπορεί να χρησιμοποιηθεί για την λεπτομερή ανάλυση του 

κυκλώματος. Η γραφική μέθοδος της εισαγωγής κυκλώματος ονομάζεται schematic 

capture.  
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3. Εισαγωγή κυκλώματος  
 
3.1 Εισαγωγή κυκλώματος με Schematic Capture 
 
 Χρησιμοποιώντας τη μέθοδο εισαγωγής κυκλώματος schematic capture 

πρέπει να επιλεγεί, κάθε φορά, το στοιχείο που θα τοποθετηθεί στο κύκλωμα προς 

υλοποίηση. Η εύρεση και η τοποθέτηση του στοιχείου αυτού πραγματοποιείται 

ακολουθώντας τα βήματα: Draw > Get New Part, ή πληκτρολογώντας την 

συντόμευση CTRL+G, όπως απεικονίζεται στην Εικόνα 4: 

 

   
Εικόνα 4: Εισαγωγή και επιλογή νέου στοιχείου. 

 

 Προκειμένου να εντοπισθεί το στοιχείου που θα εισαχθεί στο κύκλωμα κάθε 

φορά, αρκεί να τοποθετηθούν τα πρώτα γράμματα της ονομασίας του στο πεδίο Part 

Name. Στο παράδειγμα της Εικόνας 4, πληκτρολογώντας “r” εμφανίζονται όλα τα 

στοιχεία που ξεκινούν με αυτό το γράμμα και δίδεται ταυτόχρονα η δυνατότητα, 

επιλέγοντας με αριστερό κλικ το εκάστοτε στοιχείο, ο χρήστης να λάβει μία σύντομη 

περιγραφή του. Η εισαγωγή του στοιχείου πραγματοποιείται κάνοντας αριστερό κλικ 

στην επιλογή ‘Place and close’ και ακολούθως κάνοντας και πάλι αριστερό κλικ στο 

εκάστοτε σημείο της περιοχής σχεδίασης, όπου είναι επιθυμητή η τοποθέτησή του, 

εμφανίζεται το επιλεχθέν στοιχείο, εντός του καμβά. Στην περίπτωση κατά την οποία 

πραγματοποιήθηκαν οι αναγκαίες τοποθετήσεις του στοιχείου στο καμβά σχεδίασης 
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και δεν είναι πλέον επιθυμητή η εμφάνιση του στοιχείου προς τοποθέτηση στο 

κέρσορα, το στοιχείο αποδεσμεύεται με χρήση του πλήκτρου Esc ή κάνοντας δεξί 

κλικ. Το PSpice αριθμεί αυτόματα τα στοιχεία με βάση την σειρά εισαγωγής τους στο 

κύκλωμα. Σημειώνεται επιπροσθέτως ότι, πατώντας την επιλογή ‘Libraries’ δίδεται 

στο χρήστη η δυνατότητα να διαλέξει κάποια από τις βιβλιοθήκες, εμφανίζοντας 

αυτόματα τα στοιχεία που ανήκουν σε αυτή, ούτως ώστε να διευκολυνθεί στον 

εντοπισμό τους. 

 

Πίνακας 1: Βασικά παθητικά στοιχεία του PSPICE. 
 

Ονομασία Στο Pspice Βιβλιοθήκη 
Αντίσταση R Analog 

Χωρητικότητα C Analog 
Αυτεπαγωγή L Analog 

Αμοιβαία Επαγωγή XFRM_LINEAR Analog 
Γείωση AGND source 
Δίοδος D eval 

n-channel mosfet MbreakN breakout 
p-channel mosfet MbreakP breakout 

n-channel jfet JbreakN breakout 
NPN διπολικό transistor Q2N* eval 
PNP διπολικό transistor  QbreakP Breakout 

 

 Προκειμένου να γίνει η έναρξη της εξομοίωσης, σε ορισμένα στοιχεία (π.χ. 

πηγή τάσεως ημιτονοειδούς μορφής - VSIN) είναι απαραίτητο να εισαχθούν οι 

αρχικές τους συνθήκες (π.χ. συχνότητα, πλάτος κ.α.). Αυτό επιτυγχάνεται κάνοντας 

διπλό αριστερό κλικ στα εκάστοτε τέτοια στοιχεία. Ιδιαίτερη προσοχή χρίζει η 

τοποθέτηση της γείωσης, η οποία είναι αναγκαία και απαραίτητη και αναλύεται σε 

ακόλουθο κεφάλαιο. 

 

3.2 Χειρισμός στοιχείων 
 
 Εφόσον τοποθετηθούν τα στοιχεία για την δημιουργία του κυκλώματος στο 

καμβά σχεδίασης, ο χρήστης μπορεί να επέμβει σε αυτά επιλέγοντας τα με αριστερό 

κλικ. Το εκάστοτε στοιχείο μαρκάρεται με χρώμα κόκκινο και ακολούθως μπορεί να 

εφαρμοσθεί σε αυτό: 
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• Περιστροφή: Για την περιστροφή του στοιχείου ακολουθούνται τα βήματα 

Edit > Rotate ή η συντόμευση CTRL+R. Η περιστροφή στο PSpice γίνεται 

αντιωρολογιακά.  

 

 
Εικόνα 5: Περιστροφή εικόνας. 

 

• Αντιγραφή – Επικόλληση: Επιλέγεται Edit > Copy ή η συντόμευση CTRL+C 

και αντίστοιχα Edit > Paste ή CTRL+V. 

• Μεταφορά: Η μετακίνηση του στοιχείου πραγματοποιείται με παρατεταμένο 

πάτημα του αριστερού πλήκτρου του ποντικιού και ταυτόχρονο σύρσιμο 

αυτού στο επιθυμητό σημείο. 

• Διαγραφή: Αρκεί να πατηθεί το Del ή να επιλεγεί Edit > Delete 

Σημειώνεται ότι, οι παραπάνω χειρισμοί μπορούν να εφαρμοστούν σε 

περισσότερα του ενός στοιχεία, εφόσον αυτά επιλεχθούν συνολικά με το ποντίκι, 

πατώντας παρατεταμένα το αριστερό πλήκτρο. 

 

3.3 Τοποθέτηση διασυνδέσεων στο κύκλωμα 
 
 Μετά την εισαγωγή όλων των επιλεχθέντων στοιχείων στο καμβά σχεδίασης 

πρέπει να πραγματοποιηθεί η ορθή τοποθέτηση των διασυνδέσεων μεταξύ τους. 

Ακολουθώντας τα βήματα Draw > Wire ή με την συντόμευση CTRL+W ο κέρσορας 

λαμβάνει πλέον τη μορφή μολυβιού. Σημειώνεται ότι, με διπλό αριστερό κλικ ο 

κέρσορας αποδεσμεύεται από την εντολή Wire. 

Εν συνεχεία, η διασύνδεση μεταξύ δύο στοιχείων πραγματοποιείται πατώντας 

μια φορά αριστερό κλικ σε καθένα από τα πλησιέστερα άκρα τους που θα ενωθούν. 

Οι πολλαπλές ενώσεις καλωδίων πραγματοποιούνται με τον ίδιο ακριβώς τρόπο, ενώ 

το PSpice αναλαμβάνει την αυτόματη τοποθέτηση κόμβου σε περίπτωση σύνδεσης 

παραπάνω του ενός καλωδίων.  
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Εικόνα 6: Τοποθέτηση διασυνδέσεων. 

 

3.4 Τιμές και ονόματα στοιχείων 
 
 Ο προσδιορισμός της τιμής ενός στοιχείου πραγματοποιείται με διπλό 

αριστερό κλικ στην τιμή του στοιχείου ή εναλλακτικά, αφού πατηθεί αριστερό κλικ 

στην τιμή του στοιχείου, ακολουθούνται τα βήματα: Edit > Attributes και η 

επιθυμητή τιμή τοποθετείται στο αντίστοιχο πεδίο που εμφανίζεται.  

Με την ίδια διαδικασία δύναται να αλλαχθεί και η ονομασία του στοιχείου, 

κάνοντας, δηλαδή, διπλό αριστερό κλικ ή επιλέγοντας την προϋπάρχουσα.  

Τέλος, είναι εφικτό να αλλαχθούν και οι παράμετροι του στοιχείου, είτε με 

διπλό αριστερό κλικ σε αυτό, είτε με επιλογή του και εν συνεχεία, ακολουθώντας τα 

βήματα: Edit > Attributes. 

 

 
Εικόνα 7: Αλλαγή παραμέτρων στοιχείου. 

 

Κάθε φορά που πραγματοποιούνται αλλαγές στις παραμέτρους των στοιχείων 

πρέπει να γίνεται αποθήκευση αυτών πριν το κλείσιμο του παραθύρου (‘Save Attr.’). 

Σημειώνεται ότι, δίδεται και η δυνατότητα μεταφοράς της ετικέτας της τιμής ή 

της ονομασίας ενός στοιχείου, επιλέγοντας κάθε φορά την ετικέτα και μετακινώντας 

την με το ποντίκι στην επιθυμητή θέση. 
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3.5 Ενεργά στοιχεία 
 
 Η επιλογή των ενεργών στοιχείων είναι, σε γενικές γραμμές, ίδια με αυτή των 

παθητικών, με μόνη διαφορά ότι τα ενεργά στοιχεία αποτελούνται κατά κύριο λόγο 

από τα ακόλουθα: 

 

Πίνακας 2: Βασικά ενεργά στοιχεία του PSPICE 

 
Ονομασία Στο PSPICE Βιβλιοθήκη 

Πηγή συνεχούς τάσης VDC Source 
Πηγή εναλλασσόμενης τάσης VAC Source 
Πηγή τάσης εξαρτημένη από τάση E Analog 
Πηγή έντασης εξαρτημένη από ένταση F Analog 
Πηγή έντασης εξαρτημένη από τάση G Analog 
Πηγή τάσης εξαρτημένη από ένταση H Analog 
Παλμός VPULSE Source 
Τελεστικός ενισχυτής uA741 Eval 
Ανοιχτός διακόπτης Sw_topen Eval 
Κλειστός διακόπτης Sw_tclose Eval 

 

 Προκειμένου να χρησιμοποιηθούν τα στοιχεία αυτά και να επιτευχθεί σωστή 

εξομοίωση του κυκλώματος πρέπει πρώτα να εισαχθούν οι παράμετροί τους, οι 

οποίες αναλύονται ακολούθως: 

• Παλμός: Πρέπει να δοθούν τιμές στην τάση, στους χρόνους ανόδου και 

καθόδου και στην περίοδο. Στην Εικόνα 8 δίδονται οι απαιτούμενοι χρόνοι 

και η σημασία τους. 

 

  
Εικόνα 8: Παλμός. 

 

 13



• Πηγή συνεχούς τάσης: Πρέπει να δοθεί το πλάτος DC της τάσης. 

• Πηγή εναλλασσόμενης τάσης: Είναι αναγκαίο να καθοριστούν τα πλάτη DC 

και AC της τάσης.  

• Εξαρτημένη πηγή τάσης και ρεύματος: Είναι  απαραίτητη η σύνδεση της με 

το εξαρτώμενο μέγεθος και η δήλωση του κέρδους. 

 
Εικόνα 9: Τάσεις. 

 

• Τελεστικός ενισχυτής: Πρέπει να ενωθούν τα άκρα 4 και 7 με μια τάση 12V. 

Σημειώνεται ότι, οι είσοδοι του είναι οι ακροδέκτες 2 και 3, ενώ ως έξοδο έχει 

τον ακροδέκτη 6. 

 

 
Εικόνα 10: Τελεστικός Ενισχυτής. 

 

• Διακόπτης: Πρέπει να δηλωθεί ο χρόνος ανοίγματος/κλεισίματος. Στο PSpice 

ο διακόπτης λειτουργεί σαν μια αντίσταση που μεταβάλλεται από μια τιμή 

πολύ χαμηλή (Rclosed) σε μια τιμή πολύ υψηλή (Ropen) ή το αντίθετο, στην 

περίπτωση, δηλαδή, κατά την οποία μεταβαίνει από ανοιχτό κύκλωμα σε 

κλειστό, σε μικρό χρονικό διάστημα. 
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Εικόνα 11: Παράμετροι Διακόπτη. 

 

Όταν δημιουργηθεί γραφικά το επιθυμητό κύκλωμα είναι απαραίτητο να 

αποθηκευτεί με την κατάληξη ‘.sch’, όπως διαφαίνεται και ακολούθως: 

 

 
Εικόνα 12: Αποθήκευση αρχείου. 

 

 Τονίζεται ότι, για να πραγματοποιηθεί η εξομοίωση πρέπει να έχει τοπο-

θετηθεί στο κύκλωμα αναλογική γείωση, η οποία δηλώνει την τάση αναφοράς 0. Σε 

αντίθετη περίπτωση, όπου δεν έχει τοποθετηθεί η γείωση στο κύκλωμα, δεν είναι 

εφικτό να πραγματοποιηθεί η εξομοίωση του κυκλώματος από το PSpice. 

Η τοποθέτηση της αναλογικής γείωσης γίνεται ακολουθώντας από το μενού 

τα βήματα: Get New Part > Analog Ground και εν συνεχεία τοποθετείται στον 

αναγκαίο κόμβο, κατά τον ίδιο τρόπο που τοποθετήθηκαν τα στοιχεία, προσδι-

ορίζοντας την τάση αναφοράς. 
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Εικόνα 13: Τοποθέτηση αναλογικής γείωσης. 

 

 Σε αυτό το σημείο έχει δημιουργηθεί το κύκλωμα μέσα στην περιοχή 

σχεδίασης. Εάν πραγματοποιηθεί zoom out εμφανίζεται ολόκληρο το πλαίσιο, όπου 

κάτω δεξιά δίδονται πληροφορίες για τον σχεδιασμό. Είναι δυνατή η αλλαγή των 

πληροφοριών αυτού του πλαισίου χρησιμοποιώντας την επιλογή Edit > Attributes, 

εφόσον βέβαια έχει προηγηθεί η επιλογή του.  
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Εικόνα 14: Περιοχή σχεδίασης. 

 

 
Εικόνα 15: Πλαίσιο πληροφοριών περιοχής σχεδίασης. 

 

3.6 Εισαγωγή κυκλώματος με Netlist 
 
 Ένα αρχείο Netlist περιέχει μια λίστα από ονόματα στοιχειών που υπάρχουν 

στο κύκλωμα, τις τιμές τους και τον τρόπο με τον οποίο συνδέονται μεταξύ τους, ενώ 

επιπρόσθετα εμπεριέχεται και ο τρόπος εκτέλεσης του εξομοιωτή PSpice. 

 Προκειμένου να είναι εφικτή η εισαγωγή του επιθυμητού κύκλωματος με την 

βοήθεια του Netlist κατ’ αρχάς πρέπει να γίνει επιλογή από το μενού του Schematics 

των βημάτων: Analysis > Create Netlist.  
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Η εισαγωγή των επιθυμητών στοιχειών για την δημιουργία του κυκλώματος 

είναι πλέον δυνατή και ακολουθώντας τα βήματα: Analysis > Examine Netlist θα 

εμφανιστεί το text editor, στο οποίο η πρώτη γραμμή αναγράφει *Schematics Netlist* 

(Εικόνα 16-18). 

 

 
Εικόνα 16: Δημιουργία Netlist. 

 

 
Εικόνα 17: Examine Netlist. 

 

 
Εικόνα 18: Edit Netlist. 
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 Αμέσως μετά την γραμμή *Schematics Netlist* ο χρήστης εισάγει τα στοιχεία 

και τις παραμέτρους τους. Στο παράδειγμα της Εικόνας 18 απεικονίζεται η τάση και 

οι αντιστάσεις που έχουν δημιουργηθεί με το Schematics, καθώς και οι κόμβοι στους 

οποίους συνδέονται, οι τιμές των τάσεων και των αντιστάσεων. Για την επεξεργασία 

του Netlist ισχύουν τα ακόλουθα:  

• Η σύνταξη των στοιχείων ενός κυκλώματος είναι: 

[τύπος] όνομα [θετικός κόμβος] [αρνητικός κόμβος] [τιμή στοιχείου]. 

• Οι τιμές των στοιχείων ακολουθούνται από ένα σύμβολο που δηλώνει τις 

δυνάμεις του 10, δηλαδή όπου f: 10-15, p: 10-12, n: 10-9, u: 10-6, m: 10-3, k: 103, 

Meg: 106, G: 109 και όπου T: 1012. 

• Οι κόμβοι του κυκλώματος καθορίζονται με αριθμούς, όπου η γείωση 

δηλώνεται με το 0.  

• Χρήση του * για ενδεχόμενα σχόλια. 

• Χρήση ‘.END’ ή ‘.end’ στην τελευταία γραμμή του προγράμματος (σημειώ-

νεται ότι το PSPICE δεν είναι case sensitive). 

• Χρήση ‘;’ για διαχωρισμό των εντολών μεταξύ τους. 

• Χρήση ‘+’ για συνέχεια μίας εντολής στην επόμενη γραμμή. 

Επιπρόσθετα, μερικές εντολές που μπορούν να χρησιμοποιηθούν για την ανάλυση 

του κυκλώματος και οι οποίες πρέπει πάντα να ξεκινούν με τελεία (.) είναι οι 

ακόλουθες: 

• .OP (Σημείο Λειτουργίας): Υπολογίζει την τάση των κόμβων και τα ρεύματα 

κάθε πηγής. 

• .DC (DC Σάρωση): Υπολογίζει τις τάσεις όλων των κόμβων και τα ρεύματα 

όλων των βρόγχων. 

.DC SRCname START STOP STEP 

 .DC V1 0 20 2 

• .TF (Συνάρτηση μεταφοράς H(s)=Vout/Vin): 

.TF [όνομα τάσης εξόδου] [τάση εισόδου] 

.TF V(3,0) Vin 

Η δήλωση V(3,0) υποδεικνύει τη διαφορά δυναμικού μεταξύ των κόμβων 3 

και 0. 

• .TRAN (Transient Analysis): 

.TRAN TSTEP TSTOP TSTART  
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 .TRAN 0.02 20 0 

• .AC (Ανάλυση AC): 

.AC LIN NP [Number of points Frequency Start] [Frequency top] 

.AC DEC NP [Number of points per decade Frequency Start] [Frequency top] 

.AC DEC 10 1000 1E6 

Μετά την δημιουργία του κυκλώματος ο χρήστης πρέπει να αποθηκεύσει το 

αρχείο που έχει δημιουργήσει και το οποίο εν συνεχεία θα εξομοιωθεί, αποσκο-

πώντας στην παραγωγή των ζητούμενων αποτελεσμάτων.  
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4. Εξομοίωση του κυκλώματος 
 
 Μετά την δημιουργία του κυκλώματος, με οποιονδήποτε από τους δύο τρό-

πους που αναλύθηκαν, είναι δυνατή η εξομοίωση του με χρήση του PSpice και η 

ανάλυση του με μεγάλη λεπτομέρεια. Με επιλογή του κίτρινου εικονιδίου 

(‘Simulate’), αριστερά στην οριζόντια μπάρα επιλογής, ή πατώντας το πλήκτρο F11 

και εφόσον έχει αποθηκευτεί το αρχείο, εμφανίζεται το παράθυρο Pspice (Εικόνα 19).  

 

 
Εικόνα 19: PSpice Simulator. 

 

4.1. Δείκτες 
 
  Το PSpice παρέχει την δυνατότητα προσδιορισμού της τιμής της τάσεως ή 

του ρεύματος προεπιλεγμένων κόμβων του κυκλώματος. Με την επιλογή ‘Markers’ 

καθορίζεται, ανάλογα με την περίσταση, το μέγεθος που είναι επιθυμητό να 

προσδιοριστεί και να εμφανιστεί στην εξομοίωση. Το ίδιο επιτυγχάνεται και με την 

επιλογή του αντίστοιχου εικονιδίου, όπου δίδονται οι βασικές επιλογές: εμφάνιση της 

τάσης και του ρεύματος. 

• Δείκτης τάσεως: Εμφανίζει την τάση του επιλεγμένου, από τον δείκτη (Εικόνα 

20), κόμβο σε σχέση με τον κόμβο που έχει καθοριστεί ως γείωση.  
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• Δείκτης ρεύματος: Εμφανίζει την ένταση του ρεύματος που διαπερνά τον 

επιλεγμένο, από τον αντίστοιχο δείκτη, κόμβο. 

 

 
Εικόνα 20: Δείκτες. 

 

Πέραν των προαναφερθέντων δεικτών, το PSpice παρέχει τη δυνατότητα 

χρήσης και άλλων τύπων δεικτών. Οι δείκτες αυτοί επιλέγονται και τοποθετούνται 

στο κύκλωμα ακολουθώντας τα βήματα: Markers > Mark Advanced. 

 

4.2 Ρυθμίσεις για την εξομοίωση 
 
 Η επιλογή της ανάλυσης του σχεδιασμένου κυκλώματος, την οποία επιθυμεί 

να πραγματοποιήσει ο χρήστης, δίδεται ακολουθώντας τα βήματα: Analysis > Setup. 
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Εικόνα 21: Setup Εξομοίωσης. 

 

Οι επιλογές που παρέχονται διαφαίνονται στην Εικόνα 22: 

 

 
Εικόνα 22: Επιλογές εξομοίωσης. 

 

• Transient: Με τον συγκεκριμένο τύπο ανάλυσης εμφανίζεται η απόκριση του 

κυκλώματος στο πέρασμα του χρόνου. Το πρώτο βήμα για την δημιουργία της 

εξομοίωσης είναι η εισαγωγή του χρόνου, για τον οποίο θα πραγματοποιηθεί 

η εξομοίωση. Ακόμη, το Pspice δίνει την δυνατότητα εμφάνισης των 

δεδομένων μετά από κάποιο χρονικό διάστημα, ούτως ώστε να κάνει την 
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εξομοίωση πιο γρήγορη. Επιπρόσθετα, δίδεται και η επιλογή για το χρονικό 

διάστημα που θα μεσολαβήσει ανάμεσα σε δύο σημεία εξομοίωσης. 

 

 
Εικόνα 23: Transient ανάλυση. 

 

• DC Sweep: Το PSpice δημιουργεί μια συνεχή ανάλυση του κυκλώματος, 

σύμφωνα με κάποια μεταβλητή του προγράμματος, που έχει προεπιλέξει ο 

χρήστης και η οποία μπορεί να αλλάζει τιμές κατά την διάρκεια εξομοίωσης. 

Η επιλεχθείσα μεταβλητή μπορεί να αντιστοιχεί σε πηγή τάσης ή ρεύματος, σε 

μια παράμετρο ενός μοντέλου ή ακόμα και σε θερμοκρασία. Εφόσον επιλεγεί 

ο τύπος της μεταβλητής, εν συνεχεία, δίδεται η ονομασία του συγκεκριμένου 

στοιχείου που θα χρησιμοποιηθεί. Τέλος, δίδονται τα χαρακτηριστικά της 

γραφικής παράστασης που θα δημιουργηθεί, καθώς και οι τιμές που θα λάβει 

η επιλεχθείσα μεταβλητή κατά τη διάρκεια της εξομοίωσης. 
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Εικόνα 24: DC Sweep ανάλυση. 

 

• AC Sweep: Με αυτή την επιλογή δημιουργείται μία γραφική παράσταση 

συχνότητας, η οποία επιτρέπει τον υπολογισμό των διαγραμμάτων Bode και 

Nyquist ή ακόμη και την κατασκευή μιας καμπύλης για την λειτουργία του 

κυκλώματος σε διαφορετικές συχνότητες. Αρχικά επιλέγεται η μορφή της 

ανάλυσης, δηλαδή εάν θα είναι γραμμική ή λογαριθμική, όπου στην τελευταία 

περίπτωση δίδεται η δυνατότητα επιλογής dB ή οκτάδων. Ακολούθως, 

δίδονται επιλογές για τον καθορισμό της αρχικής και της τελικής τιμής, καθώς 

και το πλήθος των ενδιάμεσων σημείων που θα χρησιμοποιήσει η ανάλυση. 

 

 
Εικόνα 25: AC Sweep Ανάλυση. 
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• Parametric: Με την παραμετρική ανάλυση, το PSpice δίδει την δυνατότητα να 

μεταβάλλεται ένα προεπιλεγμένο τμήμα του κυκλώματος κατά την διάρκεια 

της εξομοίωσης. 

 

4.3 Εκτέλεση της εξομοίωσης 
 
 Προκειμένου να πραγματοποιηθεί η εξομοίωση, έπειτα από τον προσδιορισμό 

της ανάλυσης που θα χρησιμοποιηθεί, το αρχείο αποθηκεύεται και επιλέγεται το 

‘Simulate’ ή η χρήση του πλήκτρου F11. Εφόσον δεν υπάρχουν λάθη εμφανίζεται το 

παράθυρο του εξομοιωτή (Εικόνα 26). 

 

 
Εικόνα 26: PSpice Simulator. 

 

 Το default στην εμφάνιση μίας ανάλυσης είναι ότι η μεταβαλλόμενη 

μεταβλητή έχει τοποθετηθεί στον άξονα x. Ο χρήστης, όμως, έχει την δυνατότητα εάν 

θελήσει να επιλέξει κάποια άλλη μεταβλητή προς τοποθέτηση στους άξονες ή ακόμη 

και να προσδιορίσει τη μορφή με την οποία θα εμφανιστεί η ανάλυση, ακολουθώντας 

τα βήματα: Plot > Axis Settings. 
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Εικόνα 27: Επιλογή Axis Settings. 

 

 
Εικόνα 28: Axis Settings. 
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 Σύμφωνα με τις Εικόνες 27 και 28, ο χρήστης δύναται να πραγματοποιήσει τις 

απαραίτητες αλλαγές, έτσι ώστε το αποτέλεσμα να εμφανιστεί στην επιθυμητή 

μορφή. Επιπλέον, το PSpice δίνει και την δυνατότητα υπολογισμού των μεταβλητών. 

Ουσιαστικά, επιτρέπει πράξεις πάνω στις ήδη υπάρχουσες μεταβλητές του 

κυκλώματος. Εάν επιλεγεί το ‘Axis Variable’ εμφανίζεται το ακόλουθο παράθυρο 

(Εικόνα 29), το οποίο επιτρέπει την εμφάνιση οποιασδήποτε παράστασης μεταξύ των 

μεγεθών των κόμβων του κυκλώματος, στους άξονες. 

 

 
Εικόνα 29: X Axis Variable. 

 

 Εν συνεχεία, μετά την δημιουργία του άξονα x, πρέπει να επιλεγεί προς 

εμφάνιση και η μεταβλητή στον άξονα y, εφαρμογή που λαμβάνει χώρα από τον 

χρήστη ακολουθώντας τα βήματα: Trace > Add Trace ή πατώντας στο αντίστοιχο 

εικονίδιο.  
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Εικόνα 30: Επιλογή Add Trace. 

 

 
Εικόνα 31: Add Trace. 

 

 29



 Στην Εικόνα 31 απεικονίζεται το παράθυρο από το οποίο επιλέγεται η  

παράσταση η οποία τελικά θα σχεδιαστεί γραφικά και θα εμφανιστεί, ακολούθως, στο 

παράθυρο του εξομοιωτή (Εικόνα 32). 

 

 
Εικόνα 32: Αναπαράσταση ρεύματος – τάσης στην R7.  

 

4.4 Χρήση αποτελεσμάτων 
 
 Έχοντας κατασκευάσει την γραφική παράσταση (Εικόνα 32), ο χρήστης 

μπορεί να εξάγει χρήσιμα αποτελέσματα, όπως τις τιμές από την καμπύλη που 

προέκυψε, με απλή χρήση του κέρσορα. Η εφαρμογή αυτή, όμως, μπορεί να 

πραγματοποιηθεί μόνο εάν είναι ενεργοποιημένη η συγκεκριμένη δυνατότητα, μέσω 

των βημάτων: Trace > Cursor > Display (Εικόνα 33). 
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Εικόνα 33: Εμφάνιση κέρσορα. 

 

 Επομένως, μετακινώντας το ποντίκι επάνω στις επιθυμητές θέσεις της 

καμπύλης και κάνοντας αριστερό κλικ είναι δυνατόν να ανευρεθούν οι τιμές στα 

συγκεκριμένα σημεία επιλογής. Ταυτόχρονα, ενεργοποιούνται και τα εικονίδια της 

Εικόνας 34, τα οποία δίνουν την δυνατότητα επιλογής μέγιστων και ελάχιστων, 

τοπικών και μη, καθώς και τοποθέτησης ετικετών σε οποία σημεία της καμπύλης 

επιθυμεί ο χρήστης. 

 

 
Εικόνα 34: Επιλογές σημείων καμπύλης. 

 

 Σημειώνεται ότι, δίδεται η δυνατότητα εξαγωγής των δεδομένων και σε 

κάποιο άλλο πρόγραμμα, όπως π.χ. το Matlab ή to Excel,  αποσκοπώντας σε περαι-

τέρω επεξεργασία τους. Προκειμένου να πραγματοποιηθεί αυτό, αρχικά, ο χρήστης 

πρέπει να επιλέξει με το ποντίκι την μεταβλητή της οποίας τα αποτελέσματα επιθυμεί 

να χρησιμοποιήσει.  

 

 
Εικόνα 35: Επιλογή μεταβλητής. 
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Ακολούθως, έπειτα από την επιλογή της μεταβλητής, κάνοντας Edit > Copy οι 

τιμές της μεταβλητής αντιγράφονται. Εν συνεχεία, γίνεται επιλογή επικόλλησης 

(Paste) στο πρόγραμμα όπου θα πραγματοποιηθεί η μεταφορά των δεδομένων. 

Ανάλογα με την έκδοση των προγραμμάτων που χειρίζεται ο χρήστης υπάρχει 

πιθανότητα εμφάνισης προβλημάτων που σχετίζονται με το Format.  
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5. Παραδείγματα 
 
5.1 DC κύκλωμα  
 
 Στο παράδειγμα αυτό, στόχος είναι η υλοποίηση ενός απλού ηλεκτρικού 

κυκλώματος (Εικόνα 36) χρησιμοποιώντας το PSpice. Όπως έχει προαναφερθεί στο 

Κεφάλαιο 3, πρώτιστα πρέπει να πραγματοποιηθεί εισαγωγή του κυκλώματος στο 

PSpice Schematics.  

 

 
Εικόνα 36: Απλό ηλεκτρικό κύκλωμα. 

 

 Αρχικά, εισάγονται τα στοιχεία από τα οποία αποτελείται το κύκλωμα. Η 

αντίσταση που θα χρησιμοποιηθεί επιλέγεται από το μενού: Draw > Get New Part και 

τοποθετείται με αριστερό κλικ στο επιθυμητό σημείο στον καμβά σχεδίασης του 

Schematic (Εικόνα 37).  
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Εικόνα 37: Τοποθέτηση αντιστάσεων του κυκλώματος. 

 

 Κάθε αντίσταση τοποθετείται οριζόντια και ακολούθως με χρήση της 

επιλογής της περιστροφής δίδεται, όπου είναι απαραίτητο, η σχετική θέση των 

αντιστάσεων σε σύγκριση με το κύκλωμα το οποίο ζητείται να υλοποιηθεί. 

Επομένως, επιλέγεται η αντίσταση που είναι αναγκαίο να περιστραφεί και με την 

συντόμευση CTRL+R λαμβάνει την επιθυμητή θέση.  

Εν συνέχεια, τοποθετείται η απαραίτητη πηγή στο κύκλωμα, ακολουθώντας 

από το μενού τα βήματα: Draw > Get New Part. Στην προκειμένη περίπτωση, λοιπόν, 

η πηγή συνεχούς τάσης ονομάζεται VDC. Υπενθυμίζεται ότι, η αποδέσμευση ενός 

στοιχείου από τον κέρσορα επιτυγχάνεται με δεξί κλικ ή πατώντας το πλήκτρο Esc.  
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Εικόνα 38: Τοποθέτηση τάσης. 

 

 Ακολούθως, η τοποθέτηση των συνδέσεων μεταξύ των στοιχείων, που έχουν 

εισαχθεί στο Schematic, πραγματοποιείται ακολουθώντας τα βήματα: Draw > Wire. 

Ο κέρσορας λαμβάνει τη μορφή μολυβιού, με το οποίο κάνοντας αριστερό κλικ στα 

άκρα των στοιχείων που πρέπει να ενωθούν, παράγεται η σύνδεση (βλ. Κεφάλαιο 

3.3). Εφαρμόζοντας την ανωτέρω διαδικασία για όλα τα στοιχεία που πρέπει να 

συνδεθούν, κατασκευάζεται το ακόλουθο κύκλωμα, το οποίο είναι και το ζητούμενο 

(Εικόνα 39). 
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Εικόνα 39: Τοποθέτηση καλωδιώσεων. 

 

 Για να την ορθή κατασκευή του κυκλώματος πρέπει να εισαχθούν όλες οι 

τιμές των στοιχείων της εκφώνησης του παραδείγματος, είτε μέσω της επιλογής από 

το μενού: Edit > Attributes, είτε με διπλό αριστερό κλικ επάνω στις αντίστοιχες τιμές. 

Ακόμη, είναι απαραίτητη η εισαγωγή της τάσης αναφοράς, δηλαδή της αναλογικής 

γείωσης με δυναμικό 0, επιλέγοντας ‘AGND’ από το ‘Get New Part’. Όπως έχει  

προαναφερθεί, είναι δυνατή η επεξεργασία των πληροφοριών της περιοχής 

σχεδίασης, από το πλαίσιο που βρίσκεται στο κάτω δεξιό μέρος του κυκλώματος που 

έχει υλοποιηθεί. 

 Η εξαγωγή των αποτελεσμάτων του κυκλώματος πραγματοποιείται με 

ποικίλους τρόπους. Είναι, λοιπόν, δυνατή η εμφάνιση των τιμών των τάσεων και των 

ρευμάτων κάθε γραμμής του κυκλώματος, με οποιονδήποτε συνδυασμό κάθε φορά, 

ακολουθώντας τα βήματα: Analysis > Display Results on Schematic > Enable 

(Εικόνα 40).  
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Εικόνα 40: Επιλογή εμφάνισης αποτελεσμάτων στο διάγραμμα. 

 

 
Εικόνα 41: Αποτελέσματα επάνω στο διάγραμμα. 
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 Ένα από τα βασικά πλεονεκτήματα του PSpice είναι ότι παρέχει στον χρήστη 

την ευκολία στην επίλυση ενδεχόμενων προβλημάτων. Έστω λοιπόν ότι, ζητείται από 

τον χρήστη να προσδιορίσει το φορτίο που θα πρέπει να εισαχθεί έτσι ώστε η τάση 

στα άκρα Α-Β να είναι 1.5 V. 

 Αρχικά, πρέπει να τοποθετήσει το φορτίο R7 παράλληλα με την αντίσταση 

R1, αποσκοπώντας στην μέτρηση του ρεύματος διαμέσου της αντιστάσεως R7 σαν 

συνάρτηση της τάσης στα άκρα της. Η βασική μεθοδολογία αποτελείται από:  

- τον ορισμό της αντίστασης R7 σαν μια μεταβλητή του PSpice,  

- τον ορισμό αυτής της μεταβλητής σαν μια παράμετρο, η οποία θα μεταβάλ-

λεται κατά την διάρκεια της εξομοίωσης του κυκλώματος,  

- την δήλωση στην εξομοίωση ότι θα μεταβάλλεται η παράμετρος αυτή,  

- την εκτέλεση της εξομοίωσης,  

- τη χρήση του Probe ώστε να σχεδιαστεί το ρεύμα της R7 σαν συνάρτηση της 

τάσης στα άκρα της και 

- τη χρήση του κέρσορα με σκοπό την εύρεση του ρεύματος που διαρρέει την 

R7 όταν στα άκρα της έχει τάση ίση με 1.5 V.  

Ακολούθως, θα παρατεθούν διεξοδικά οι διαδικασίες που λαμβάνουν χώρα σε κάθε 

βήμα της μεθοδολογίας. 

Αρχικά, εισάγεται κατά τον γνωστό τρόπο μια ακόμα αντίσταση, η R7 και 

διασυνδέεται παράλληλα με την αντίσταση R1 (Εικόνα 42). 
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Εικόνα 42: Τοποθέτηση φορτίου R7. 

 

 Για τον ορισμό της αντίστασης αυτής ως μιας μεταβλητής του PSpice πρέπει 

να μεταβληθεί η τιμή της από default σε ένα όνομα, π.χ. RVAL, το οποίο εσωκλείεται 

μέσα σε αγκύλες (Εικόνα 43).  

 

 
Εικόνα 43: Δήλωση της R7 ως μεταβλητή. 

 

 Εν συνέχεια, ορίζεται αυτή η μεταβλητή ως παράμετρος, η οποία θα 

μεταβάλλεται κατά την διάρκεια της εξομοίωσης, επιλέγοντας από το μενού Draw > 

Get New Part, το στοιχείο που ονομάζεται PARAM (Εικόνα 44) και τοποθετείται σε 

οποιοδήποτε σημείο του στο κυκλώματος. 
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Εικόνα 44: Εισαγωγή στοιχείου για την δήλωση της μεταβλητής R1 ως παράμετρο. 

 

 Ακολούθως, προκειμένου να οριστεί το όνομα και η default τιμή του 

στοιχείου που θα αποτελέσει παράμετρο στην εξομοίωση, εφαρμόζεται διπλό 

αριστερό κλικ επάνω στο στοιχείο ‘PARAMETERS’, γεγονός που οδηγεί στην 

εμφάνιση του παραθύρου της Εικόνας 45..  

 

 
Εικόνα 45: Δήλωση της μεταβλητής R7 ως παραμέτρου και τοποθέτηση της default τιμής της. 
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 Οι προαναφερθείσες εφαρμογές οδηγούν στην κατασκευή του κυκλώματος 

της Εικόνας 46, στο οποίο πρέπει να εμφανίζεται τόσο το όνομα της PSpice 

μεταβλητής όσο και η default τιμή της, αφού σε αντίθετη περίπτωση θα εμφανιστεί 

μήνυμα λάθους κατά την εκτέλεση της εξομοίωσης. 

 

 
Εικόνα 46: Εμφάνιση της R7 ως παραμέτρου. 

 

 Ακολουθώντας τα βήματα: Analysis > Setup >DC Sweep ο χρήστης δηλωνεί 

την μεταβλητή αυτή στην εξομοίωση και κατ’ αυτόν τον τρόπο γίνεται ο ορισμός της 

ως παραμέτρου. Προκειμένου τα αποτελέσματα να παρουσιαστούν με καλύτερη 

μορφή επιλέγονται 10 σημεία ανά δεκάδα, δηλαδή για κάθε δύναμη του 10 να 

εμφανίζονται και δέκα σημεία, με αρχική τιμή την 0.1 και τελική την 10k.  
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Εικόνα 47: Διαμόρφωση της DC SWEEP ανάλυσης με βάση την παράμετρο R7. 

 

 Το αρχείο αποθηκεύεται με κατάληξη ‘.sch’ και ακολούθως γίνεται η έναρξη 

της εξομοίωσης, εφαρμόζοντας αριστερό κλικ στο κίτρινο εικονίδιο του Pspice 

(‘Simulate’) ή χρησιμοποιώντας το πλήκτρο F11. Μετά το πέρας της εξομοίωσης 

εμφανίζεται το παράθυρο της Εικόνας 48. 

 

 
Εικόνα 48: Παράθυρο PSpice Simulator. 
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 Ο χρήστης επιλέγει την σχεδίαση του ρεύματος που διαρρέει την αντίσταση 

R7, συναρτήσει της τάσεως στα άκρα της, με στόχο να προσδιορίσει την απαιτούμενη 

αντίσταση. Ακολουθώντας από το μενού τα βήματα: Plot > Axis Settings και στην 

συνέχεια πατώντας το ‘Axis Variable’ επιλέγει την τάση στα άκρα της R7, η οποία, 

ουσιαστικά, αντιστοιχεί στην τάση στο αριστερό άκρο της R7 μείον την τάση στο 

δεξιό άκρο της, δηλαδή V(R7:1)-V(R7:2). Οι τελεστέοι επιλέγονται από το αριστερό 

παράθυρο, ενώ οι τελεστές από το δεξί. Επιπρόσθετα, είναι εφικτό να μεταβληθεί το 

εύρος των τιμών που απεικονίζονται στην γραφική, ούτως ώστε αντί για αυτόματη 

ανάθεση των τιμών στους άξονες να δίδεται το επιθυμητό εύρος τιμών από τον 

χρήστη. Αυτό επιτυγχάνεται επιλέγοντας στο ‘Data Range, αντί για ‘Auto Range’, το 

‘User Define’ και ορίζοντας το εύρος στα αντίστοιχα πεδία. 

 Εν συνεχεία, η εμφάνιση του ρεύματος που διαρρέει την αντίσταση R7 

εισάγεται στον άξονα y της γραφικής παράστασης, μέσω της επιλογής ‘Add Trace’, η 

οποία εμφανίζει ένα παράθυρο, παρεμφερές με αυτό του άξονα x. Από το παράθυρο, 

λοιπόν, που εμφανίζεται, επιλέγεται η ποσότητα που πρέπει να αναπαρασταθεί 

συναρτήσει της ποσότητας που έχει επιλεγεί στον άξονα x. Εφόσον στην 

συγκεκριμένη περίπτωση το ζητούμενο είναι το ρεύμα της R7, μετά την επιλογή του 

προς εμφάνιση, στον άξονα y εμφανίζεται η γραφική παράσταση της Εικόνας 49. 
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Εικόνα 49: Γραφική παράσταση εντάσεως – τάσεως της αντίστασης R7. 

 

 Ο χρήστης ενεργοποιεί την εμφάνιση των τιμών ακολουθώντας τα βήματα: 

Trace > Cursor > Display ή πατώντας στο αντίστοιχο εικονίδιο της μπάρας εργασίας. 

Με αυτή την διαδικασία είναι εφικτή η απόκτηση των επιθυμητών τιμών από την 

γραφική παράσταση, πατώντας στο επιθυμητό σημείο της καμπύλης με τον κέρσορα. 

Προκειμένου να υπολογιστεί το φορτίο, που είναι απαραίτητο έτσι ώστε η 

τάση στην έξοδο να ισούται με 1.5 V, είναι αναγκαία η εύρεση του ρεύματος που 

διαπερνά την αντίσταση R7 και η οποία έχει τάση στα άκρα της ίση με 1.5 V. 
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Εικόνα 50: Τιμές από την γραφική παράσταση με τοποθέτηση του κέρσορα στο επιθυμητό σημείο 

(π.χ. 1.5V). 
 

 Παρατηρώντας την γραφική παράσταση της Εικόνας 50 και εστιάζοντας στη 

θέση του κέρσορα που δίνει τις αντίστοιχες τιμές από την καμπύλη, γίνεται αντιληπτό 

ότι για τάση ίση με 1.5041 V το ρεύμα της R7 είναι ίσο με 714.035μA και επόμενα η 

τιμή της αντίστασης R7 δίδεται από τη σχέση: 

R7(for 1.5V)=1.5041V/714.035μΑ=2106.5Ω 

 

5.2 Φίλτρα 
 
5.2.1 Κατωδιαβατά Φίλτρα 
 
 Κατωδιαβατά φίλτρα ονομάζονται τα κυκλώματα που επιτρέπουν την 

διέλευση των σημάτων χαμηλών συχνοτήτων, ενώ ταυτόχρονα αποτρέπουν την 

διέλευση των σημάτων υψηλών συχνοτήτων. Ακολούθως, αναλύονται οι βασικές 

υλοποιήσεις αυτών των φίλτρων, αφ’ ενός με την χρήση στοιχείου αυτεπαγωγής και 

αφ’ ετέρου με την χρήση στοιχείου χωρητικότητας. 
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5.2.1.1 Κατωδιαβατό φίλτρο αυτεπαγωγής 
 
 Η αύξηση της συχνότητας του σήματος οδηγεί, επακόλουθα, στην αύξηση της 

εμπέδησης του πηνίου, γεγονός που έχει ως αποτέλεσμα η υψηλή εμπέδηση να 

αποκόπτει τα υψίσυχνα σήματα και να εμποδίζει την εμφάνιση τους στην έξοδο. 

Ακολούθως, στην Εικόνα 51, εμφανίζεται η υλοποίηση του φίλτρου στο PSpice, 

καθώς και η AC Sweep ανάλυση του κυκλώματος. 

 

 
Εικόνα 51: Κατωδιαβατό Φίλτρο Αυτεπαγωγής. 

 

 Αρχικά, πραγματοποιήθηκε μια AC Sweep ανάλυση του κατωδιαβατού 

φίλτρου, η οποία απεικονίζεται στην Εικόνα 52. Στην ίδια εικόνα γίνεται, επιπρό-

σθετα, αντιληπτή και η λειτουργία του κατωδιαβατού φίλτρου. 

 

 
Εικόνα 52: AC SWEEP ανάλυση κατωδιαβατού φίλτρου. 
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 Η λειτουργία του κατωδιαβατού φίλτρου βασίζεται, ουσιαστικά, στο γεγονός 

ότι το πλάτος του σήματος στην έξοδο μειώνεται όσο η συχνότητα αυξάνεται, 

έχοντας ως αποτέλεσμα την αποκοπή των υψηλών συχνοτήτων. Η συχνότητα 

αποκοπής του φίλτρου υπολογίζεται από την ανωτέρω γραφική παράσταση, ως η 

συχνότητα στην οποία το πλάτος της εξόδου βρίσκεται κάτω από την τιμή 0.707 του 

αρχικού σήματος και είναι ίση με fco=39.714 Hz. Θεωρητικά η συχνότητα αποκοπής 

προσδιορίζεται από την ακόλουθη σχέση: 

fco=R/(2πL)=1k/2*π*4H=39,79 Hz 

 Εν συνεχεία, πραγματοποιήθηκαν δύο transient αναλύσεις του κυκλώματος, 

εκ των οποίων η μία αναφερόταν σε συχνότητα 10Hz και η άλλη σε 100Hz. Ο λόγος 

που επιλέχθηκαν δύο συχνότητες έγκειται στην προσπάθεια εμφάνισης της 

λειτουργίας του κατωδιαβατού φίλτρου. Τα αποτελέσματα διαφαίνονται στις Εικόνες 

53 και 54. 

 

 
Εικόνα 53: Transient ανάλυση για συχνότητα 10Hz. 

 

 
Εικόνα 54: Transient ανάλυση για συχνότητα 100Hz. 

 

 Παρατηρώντας τις transient αναλύσεις, γίνεται κατανοητό ότι το σήμα των 

10Hz περνάει σχεδόν ακέραιο από την είσοδο στην έξοδο, ενώ το αντίστοιχο των 

100Hz αποκόπτεται σε μεγάλο βαθμό, όπως άλλωστε ήταν και το αναμενόμενο, 

σύμφωνα με την αρχή λειτουργίας του φίλτρου. 
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5.2.1.2 Κατωδιαβατό φίλτρο χωρητικότητας 
 
 Στην Εικόνα 55 περιγράφεται σχηματικά ένα κατωδιαβατό φίλτρο χωρη-

τικότητας, το οποίο λειτουργεί κατά τρόπο όμοιο με αυτόν του κατωδιαβατού 

φίλτρου αυτεπαγωγής, έχοντας ως μόνη κατασκευαστική διαφορά την παρουσία 

πυκνωτή (χωρητικότητα), αντί για πηνίου (αυτεπαγωγή). 

 

 
Εικόνα 55: Κατωδιαβατό φίλτρο χωρητικότητας. 

 

 
Εικόνα 56: AC Sweep ανάλυση. 

 

 Ο χρήστης δύναται να υπολογίσει την συχνότητα αποκοπής, τοποθετώντας 

τον κέρσορα στο επιθυμητό σημείο της καμπύλης, στη γραφική παράσταση της 

Εικόνας 56. Στην προκειμένη περίπτωση, λοιπόν, η συχνότητα αποκοπής διακρίνεται 
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να ισούται με 16.286Hz. Θεωρητικά η συχνότητα αποκοπής του κατωδιαβατού 

φίλτρου χωρητικότητας υπολογίζεται από την ακόλουθη σχέση:  

fco=1/(2*π*R*C)=1/(2*π*1kΩ*10uF)=15.92Hz 

 

5.2.2 Υψιπερατά Φίλτρα 
 

Υψιπερατά φίλτρα ονομάζονται τα κυκλώματα που επιτρέπουν την διέλευση 

των σημάτων υψηλών συχνοτήτων, ενώ ταυτόχρονα αποτρέπουν την διέλευση των 

σημάτων χαμηλών συχνοτήτων. Ακολούθως, αναλύονται οι βασικές υλοποιήσεις 

αυτών των φίλτρων, αφ’ ενός με την χρήση στοιχείου αυτεπαγωγής και αφ’ ετέρου με 

την χρήση στοιχείου χωρητικότητας. 

 

5.2.2.1 Υψιπερατό φίλτρο χωρητικότητας 
 
 Σε ένα υψιπερατό φίλτρο χωρητικότητας, όσο μειώνεται η συχνότητα του 

σήματος τόσο αυξάνει η εμπέδηση του πυκνωτή, έχοντας ως επακόλουθο την από-

κοπή των σημάτων χαμηλών συχνοτήτων στην έξοδο. Στην Εικόνα 57 απεικονίζεται 

σχηματικά η υλοποίηση ενός υψιπερατού φίλτρου χωρητικότητας. 

 

 
Εικόνα 57: Υψιπερατό φίλτρο χωρητικότητας. 
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Εικόνα 58: AC Sweep ανάλυση. 

 
 Στην Εικόνα 58 διακρίνεται η AC Sweep ανάλυση του υψιπερατού φίλτρου 

χωρητικότητας. Από την γραφική της παράσταση, υπολογίζεται, αντίστοιχα με τις 

προηγούμενες περιπτώσεις, η συχνότητα αποκοπής του φίλτρου, η οποία ισούται με 

fco=16.871Hz, ενώ θεωρητικά υπολογίζεται από την σχέση: 

fco=1/(2*π*R*C)=1/(2*π*1kΩ*10uF)=15.92Hz 

 

5.2.2.2 Υψιπερατό φίλτρο αυτεπαγωγής 
 

Αντίστοιχα, στην Εικόνα 59, απεικονίζεται σχηματικά ένα υψιπερατό φίλτρο 

αυτεπαγωγής, το οποίο λειτουργεί κατά τρόπο όμοιο με αυτόν του υψιπερατού 

φίλτρου χωρητικότητας, έχοντας ως μόνη κατασκευαστική διαφορά την παρουσία 

πηνίου (αυτεπαγωγή), αντί για πυκνωτή (χωρητικότητα). 

 

 
Εικόνα 59: Υψιπερατό φίλτρο αυτεπαγωγής. 
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Εικόνα 60: AC Sweep ανάλυση. 

 
Η συχνότητα αποκοπής του φίλτρου υπολογίζεται από την γραφική 

παράσταση της Εικόνας 60, ως η συχνότητα στην οποία το πλάτος της εξόδου 

βρίσκεται κάτω από την τιμή 0.707 του αρχικού σήματος και ισούται με fco=39.429 

Hz. Θεωρητικά η συχνότητα αποκοπής προσδιορίζεται από την ακόλουθη σχέση: 

fco=R/(2πL)=1k/2*π*4H=39,79 Hz 

 

5.3. Δίοδοι επαφής p-n 
 
 Η δίοδος επαφής p-n είναι ένα στοιχείο που επιτρέπει την διέλευση του 

ηλεκτρικού ρεύματος προς μια κατεύθυνση, απαγορεύοντας, ουσιαστικά, την κίνηση 

του προς την αντίθετη. Το ρεύμα, δηλαδή, επιτρέπεται να ρέει από την μεριά τύπου p, 

η οποία αποτελεί την άνοδο της διόδου, προς την μεριά τύπου n, που αποτελεί την 

κάθοδο της διόδου. Το ρεύμα που προσπαθεί να περάσει από την κάθοδο προς την 

άνοδο αποκόπτεται από την λειτουργία της διόδου. 

 Η δίοδος απαντάται, κατά κύριο λόγο, σε δύο περιοχές λειτουργίας, την 

αγώγιμη (ΟΝ) και την μη αγώγιμη (OFF). Επομένως, στην περίπτωση εφαρμογής 

τάσης στα άκρα της διόδου χαμηλότερης από ένα Vthreshold, η δίοδος δεν άγει και 

δημιουργείται ανοικτό κύκλωμα. Όταν η τιμή της τάσεως ξεπεράσει αυτό το όριο 

τότε η δίοδος άγει, επιτρέποντας στο ρεύμα να περάσει μέσα από αυτή, θεωρώντας 

την μια σύνδεση με μηδενική ή πολύ μικρή αντίσταση. Συνήθως, σε μια δίοδο 

πυριτίου, το Vthreshold ισούται περίπου με 0.65 V, ενώ η τιμή αυτή μπορεί να 

μεταβάλλεται για διαφορετικά είδη διόδων. Σημειώνεται ότι, όταν η δίοδος έχει 
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ανάστροφη πόλωση, το ανάστροφο ρεύμα που την διαρρέει είναι πολύ μικρής 

τάξεως. Στην περίπτωση, όμως, που η τάση της ανάστροφης πόλωσης αυξηθεί σημα-

ντικά, η δίοδος καταρρέει και την διαρρέει μεγάλο ανάστροφο ρεύμα.  

 

5.3.1 Χαρακτηριστική Ι-V διόδου p-n 
 
 Στην Εικόνα 61, απεικονίζεται σχηματικά ένα απλό κύκλωμα, σύμφωνα με το 

οποίο ο χρήστης είναι σε θέση να παρατηρήσει την λειτουργία της διόδου. Ουσια-

στικά, εφαρμόζεται μια σταθερή τάση στα άκρα της διόδου και ενδιάμεσα κάποιες 

αντιστάσεις, εκ των οποίων μία είναι μεταβαλλόμενη στην εξομοίωση, αποσκο-

πώντας στην δημιουργία της χαρακτηριστικής καμπύλης της διόδου. Πιο συγκε-

κριμένα η χαρακτηριστική καμπύλη αντικατοπτρίζει το ρεύμα που διαρρέει την δίοδο 

σε σχέση με την τάση που εφαρμόζεται στα άκρα της. 

 

 
Εικόνα 61: Κύκλωμα για τον προσδιορισμό της χαρακτηριστικής της διόδου. 

 

 Στην Εικόνα 62, παρατίθεται η χαρακτηριστική καμπύλη που προκύπτει 

έπειτα από την εξομοίωση με DC Sweep ανάλυση και έχοντας θέσει ως παράμετρο 

την αντίσταση R2 του κυκλώματος της Εικόνας 61. Αντίστοιχα με το πρώτο 

παράδειγμα, πρέπει να οριστεί η αντίσταση R2 ως μεταβλητή η οποία θα αλλάζει 

τιμές κατά την διάρκεια της εξομοίωσης. Στον άξονα x επιλέγεται να αναπαρίσταται 

η τάση στα άκρα της διόδου, ενώ στον άξονα y το ρεύμα που την διαρρέει, ούτως 

ώστε η γραφική παράσταση να απεικονίζει τη σχέση ρεύματος - τάσης. 
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Εικόνα 62: Χαρακτηριστική καμπύλη ρεύματος - τάσης της διόδου. 

 

 Από την γραφική παράσταση της Εικόνας 62 γίνεται αντιληπτό ότι, το ρεύμα 

που διαρρέει την δίοδο είναι σχεδόν μηδαμινό έως ότου η δίοδος ξεπεράσει την τάση 

κατωφλίου και επιτρέψει τη διέλευσή του. 

 

5.3.2 Δίοδος p-n ως ημιανόρθωτης 
 
 Η δίοδος δύναται να παράγει και ημιανόρθωση σε ένα κύκλωμα. Εφαρμό-

ζοντας μια εναλλασσόμενη τάση στα άκρα της διόδου παρατηρείται το φαινόμενο της 

ημιανόρθωσης, κατά το οποίο οι τάσεις, που πολώνουν ανάστροφα την δίοδο, 

αποκόπτονται, ούτως ώστε στην έξοδο να εμφανίζονται μόνο τα θετικά τμήματα της 

τάσεως. Στην Εικόνα 63 απεικονίζεται σχηματικά το κύκλωμα, το οποίο προκαλεί 

ημιανόρθωση της τάσεως εισόδου. Η τάση εισόδου δίδεται από τη σχέση: 

Vin=Vosin(2πft) 

 

 
Εικόνα 63: Κύκλωμα ημιανόρθωσης. 
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 Ακολούθως, στην Εικόνα 64 απεικονίζεται η γραφική παράσταση, που 

προέκυψε από την ανάλυση που πραγματοποιήθηκε στον χρόνο (Transient) για 

20msec, ούτως ώστε να είναι εφικτή η παρουσίαση των αποτελεσμάτων και η οποία 

επεξηγεί την ημιανόρθωση.  

 

 
Εικόνα 64: Τάση εισόδου και ημιανόρθωση στην έξοδο. 

 

 Αξίζει να σημειωθεί ότι, η τάση εξόδου πρέπει να εισαχθεί επάνω στα άκρα 

της αντιστάσεως R4 και ορίζεται ως V(R4:2) – R(R4:1), διότι ο ακροδέκτης 2 βρίσκε-

ται πλέον προς τα επάνω, λόγω της χρήσης της περιστροφής (αντιωρολογιακή κίνηση 

του στοιχείου). Παρατηρώντας τη γραφική παράσταση της Εικόνας 64 διαφαίνεται η 

αποκοπή των αρνητικών ημιπεριόδων της τάσεως εισόδου από την δίοδο και η 

διέλευση μόνο των θετικών της. Ακόμη, διακρίνεται και μια μικρή μείωση στο 

πλάτος της τάσεως εξόδου, η οποία οφείλεται σε πτώση τάσεως ίση με την τάση 

κατωφλίου της διόδου. Επιπρόσθετα, εμφανίζεται και μια καθυστέρηση της τάσεως 

εξόδου σε σχέση με την τάση εισόδου, διότι για το χρονικό διάστημα όπου το δυναμι-

κό της τάσεως εισόδου διατηρείται χαμηλότερο από την τάση κατωφλίου, η δίοδος 

δεν άγει οπότε η τάση εξόδου ισούται με 0.  

 

5.3.3 Δίοδος p-n ως πλήρης ανορθωτής 
 
 Η πλήρης ανόρθωση αποτελεί άλλη μία εκ των εφαρμογών της διόδου. Κατά 

την πλήρη ανόρθωση, οι αρνητικές ημιπερίοδοι της τάσεως εισόδου μετατρέπονται 

σε θετικές οδηγώντας στην πλήρη ανόρθωση του σήματος εισόδου στην έξοδο. Το 

κύκλωμα που προκαλεί την πλήρη ανόρθωση σήματος, χρησιμοποιώντας διόδους, 

καλείται γέφυρα διόδων και περιγράφεται σχηματικά στην Εικόνα 65. 

 

 54



 
Εικόνα 65: Γέφυρα διόδων πλήρους ανόρθωσης. 

 

 Εφαρμόζοντας χρονική ανάλυση και εξομοιώνοντας το κύκλωμα της Εικόνας 

65 προκύπτει η γραφική παράσταση της Εικόνας 66, στην οποία αντικατοπτρίζεται η 

πλήρης ανόρθωση της τάσεως εισόδου στην τάση εξόδου. 

 

 
Εικόνα 66: Πλήρης ανόρθωση στην τάση εξόδου και τάση εισόδου του κυκλώματος. 

 

 Επόμενα, προκύπτει ότι, η τάση στα άκρα της αντίστασης (φορτίο) αποτε-

λείται μόνο από θετικές ημιπεριόδους της τάσεως. Η τάση εισόδου, περνώντας μέσα 

από την γέφυρα διόδων, διέρχεται μόνο από τις αντίστοιχες διόδους που έχουν 

πολωθεί ορθά, έχοντας ως αποτέλεσμα το περιγραφόμενο κύκλωμα να λειτουργεί ως 

πλήρης ανορθωτής. Κατά αντιστοιχία με το παράδειγμα του κυκλώματος ημι-

ανόρθωσης και στην προκειμένη περίπτωση παρατηρείται μια μικρής τάξεως μείωση 

στο πλάτος της τάσεως εξόδου, καθώς και μια καθυστέρηση της εμφάνισης της 

θετικής τάσεως στην έξοδο. Το γεγονός αυτό, αδιαμφισβήτητα, οφείλεται στην 

πτώση τάσεως κατωφλίου των δύο διόδων, διαμέσου των οποίων διέρχεται η τάση 
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για να εμφανιστεί στην έξοδο. Σημειώνεται ότι, η πτώση τάσης και η καθυστέρηση 

είναι διπλάσιες από τις αντίστοιχες που λαμβάνουν χώρα κατά την ημιανόρθωση, 

καθώς η τάση περνά μέσα από δύο διόδους οπότε και λαμβάνει υπ’ όψιν της δύο 

φορές την πτώση τάσεως κατωφλίου. 

 

5.4 Ημιαγώγιμα στοιχεία τριών ακροδεκτών 
  
 Έχοντας κατανοήσει τη λειτουργία της διόδου, η οποία αποτελεί το πιο 

βασικό ημιαγώγιμο στοιχείο δύο ακροδεκτών, είναι εφικτή η μελέτη και η χρήση των 

ημιαγώγιμων στοιχείων τριών ακροδεκτών, όπως το διπολικό τρανζίστορ και το 

τρανζίστορ εγκάρσιου πεδίου. Τα τρανζίστορ βρίσκουν εφαρμογή σε ποικίλες 

χρήσεις, τόσο αναλογικές όσο και ψηφιακές. Η αρχή λειτουργία τους βασίζεται στη 

χρήση της τάσεως μεταξύ δύο ακροδεκτών προς έλεγχο του ρεύματος που διαρρέει 

τον τρίτο ακροδέκτη. 

 

5.4.1 Διπολικό τρανζίστορ BJT 
 
 Υπολογίζοντας την ύπαρξη ενός ζευγαριού μεταξύ ακροδέκτη βάσης και 

ακροδέκτη εκπομπού και ενός μεταξύ ακροδέκτη βάσης και ακροδέκτη συλλέκτη, το 

διπολικό τρανζίστορ θεωρείται ότι αποτελείται από δύο διόδους τοποθετημένες πλάτη 

με πλάτη, όπως διαφαίνεται ακόλουθα και στην σχηματική του απεικόνιση (Εικόνα 

67). Σημειώνεται όμως ότι, σε καμία περίπτωση, οι δύο δίοδοι δεν προσομοιώνουν τη 

λειτουργία του τρανζίστορ. 

 

 
Εικόνα 67: Αναπαράσταση BJT με χρήση δύο διόδων. 

 

5.4.1.1 Χαρακτηριστική Ι-V του διπολικού BJT   
  

 Στην Εικόνα 68 απεικονίζεται σχηματικά το κύκλωμα που θα χρησιμοποιηθεί 

για την επεξήγηση της λειτουργίας του διπολικού τρανζίστορ. 
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Εικόνα 68:  Κύκλωμα BJT για την εύρεση της χαρακτηριστικής IC – VCE. 

 

Ορίζοντας την τάση VCE να μεταβάλλεται κατά τη διάρκεια της εξομοίωσης 

και τοποθετώντας μια σταθερή πηγή ρεύματος στη βάση του διπολικού τρανζίστορ 

πραγματοποιείται DC Sweep ανάλυση με παράμετρο την τάση VCE. Η γραφική 

παράσταση που προκύπτει παρουσιάζεται στην Εικόνα 69. 

 

 
Εικόνα 69: Χαρακτηριστική IC – VCE  με ρεύμα πόλωσης IB=1mA. B

 

 Εν συνεχεία, μεταβάλλοντας και το ρεύμα πόλωσης κατά την διάρκεια της 

εξομοίωσης και επιλέγοντας το ‘nested sweep’ από τη DC Sweep ανάλυση 

προκύπτουν οι χαρακτηριστικές καμπύλες της Εικόνας 70, οι οποίες και προσδι-

ορίζουν τη λειτουργία του τρανζίστορ, έχοντας ως παράμετρο το ρεύμα πόλωσης. 
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Εικόνα 70:  Γραφική διερεύνηση του DC ρεύματος συλλέκτη και της τάσης VCE. 

 

 Συμπερασματικά, το ρεύμα που διαρρέει τον συλλέκτη αντιστοιχεί σε μια από 

τις γραφικές παραστάσεις που απεικονίζονται στην Εικόνα 70, ανάλογα με το ρεύμα 

πόλωσης της βάσεως του τρανζίστορ. Το σημείο λειτουργίας του τρανζίστορ βρί-

σκεται σε κάποιο σημείο επί της καμπύλης αυτής και μετακινείται ανάλογα με την 

τάση που εμφανίζεται στα άκρα του συλλέκτη και του εκπομπού του τρανζίστορ. 

 

5.4.2 Τρανζίστορ εγκάρσιου πεδίου MOSFET 
 

Το τρανζίστορ εγκάρσιου πεδίου απαντάται σε τρεις διαφορετικές περιοχές 

λειτουργίας, ανάλογα με την τάση που εφαρμόζεται στους ακροδέκτες του. Τις 

περιοχές αυτές απαρτίζουν: η περιοχή αποκοπής, η γραμμική περιοχή και η περιοχή 

κορεσμού. Η λειτουργία του MOSFET σε ψηφιακά κυκλώματα χαρακτηρίζεται από 

γρήγορη μεταγωγή από την περιοχή αποκοπής στην περιοχή κορεσμού 

Κατά την λειτουργία του τρανζίστορ στην περιοχή αποκοπής, η τάση στα 

άκρα VGS είναι μικρότερη από αυτή του κατωφλίου Vthreshold και επόμενα δεν 

επιτρέπεται η διέλευση του ρεύματος, πέραν της διέλευσης ενός πολύ μικρής τάξεως 

ρεύματος διαρροής. Όταν η τάση VGS ξεπεράσει την τάση κατωφλίου Vthreshold και 

ταυτόχρονα ισχύσει ότι η τάση μεταξύ των ακροδεκτών drain και source (VDS) είναι 

μικρότερη από την τάση VGS-Vthreshold, τότε το τρανζίστορ λειτουργεί στην ωμική 

περιοχή (γραμμική) και επιτρέπει την διέλευση ρεύματος από τον ακροδέκτη drain 

στον ακροδέκτη source. Σε αυτήν την περιοχή λειτουργίας το τρανζίστορ συμπερι-

φέρεται όπως μια αντίσταση ελεγχόμενη από τάση. Στην προκειμένη περίπτωση, η 
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ελεγχόμενη τάση ορίζεται από τις τάσεις VGS και VDS. Ολοκληρώνοντας, όταν η τάση 

VDS αυξηθεί τόσο ώστε να ξεπεράσει την τάση VGS-Vthreshold και ταυτόχρονα ισχύσει 

ότι VGS > Vthreshold, τότε το τρανζίστορ εισέρχεται στην περιοχή κορεσμού, η οποία 

χαρακτηρίζεται από σταθερή διέλευση ρεύματος. 

 

5.4.2.1 Χαρακτηριστική Ι-V του τρανζίστορ εγκάρσιου πεδίου 
MOSFET 
 
 Στην Εικόνα 71, απεικονίζεται σχηματικά το κύκλωμα που θα χρησιμοποιηθεί 

στην επεξήγηση της λειτουργίας του τρανζίστορ εγκάρσιου πεδίου (MOSFET). 

 

 
Εικόνα 71: Κύκλωμα MOSFET για την εύρεση της χαρακτηριστικής ID-VDS. 

 

Η DC Sweep ανάλυση με παράμετρο την τάση VDS πραγματοποιείται εφ’ 

όσον οριστεί η τάση VDS να μεταβάλλεται κατά τη διάρκεια της εξομοίωσης και 

τοποθετηθεί μια σταθερή πηγή τάσης στην πύλη του τρανζίστορ. Η γραφική 

παράσταση που προκύπτει παρουσιάζεται στην Εικόνα 72. 
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Εικόνα 72: Χαρακτηριστική ID – VDS  με τάση VGS=5V. 

 

 Εν συνεχεία, μεταβάλλοντας και την τάση ανάμεσα στην πύλη και την πηγή, 

κατά την διάρκεια της εξομοίωσης και επιλέγοντας ακολούθως το ‘nested sweep’ από 

τη DC Sweep ανάλυση, προκύπτουν οι χαρακτηριστικές καμπύλες της Εικόνας 73, οι 

οποίες και προσδιορίζουν τη λειτουργία του τρανζίστορ, έχοντας ως παράμετρο την 

τάση VGS. 

 

 
Εικόνα 73: Γραφική διερεύνηση του DC ρεύματος υποδοχής και της τάσης VDS. 

 

 Συμπερασματικά, το ρεύμα που διαρρέει την υποδοχή αντιστοιχεί σε μια από 

τις γραφικές παραστάσεις που απεικονίζονται στην Εικόνα 73, ανάλογα με την τάση 
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VGS του τρανζίστορ. Οι ανωτέρω χαρακτηριστικές καμπύλες υποδεικνύουν τις τρεις 

περιοχές λειτουργίας του τρανζόστορ: την περιοχή αποκοπής, όπου το ρεύμα στην 

υποδοχή είναι μηδενικό, την ωμική περιοχή, όπου το ρεύμα αυξάνεται γραμμικά με 

τη VDS, και την περιοχή κορεσμού, στην οποία το ρεύμα παραμένει σταθερό. Σε αυτή 

την περιοχή επιλέγεται να λειτουργήσει το MOSFET, όταν πρόκειται να λειτουργήσει 

ως ενισχυτής. 

 
5.4.2.2 Τρανζίστορ εγκάρσιου πεδίου MOSFET ως αντιστροφέας 
 
 Τα τρανζίστορ MOSFET δύνανται να χρησιμοποιηθούν σε ποίκιλες 

συνδεσμολογίες, αποσκοπώντας στην υλοποίηση λογικών κυκλωμάτων, το 

βασικότερο εκ των οποίων αποτελεί ο ‘αντιστροφέας’. Στην Εικόνα 74, διακρίνεται η 

υλοποίηση ενός αντιστροφέα με συνδεσμολογία CMOS, η οποία περιλαμβάνει ένα 

τρανζίστορ PMOS και ένα NMOS. 

 

 
Εικόνα 74: Αντιστροφέας με συνδεσμολογία CMOS. 

 
Κατασκευάζοντας την συνδεσμολογία της Εικόνας 74 και πραγματοποιώντας 

μια Transient ανάλυση, παράγεται η γραφική παράσταση της Εικόνας 75, όπου 

απεικονίζεται η λειτουργία του αντιστροφέα. 
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Εικόνα 75: Λειτουργία του CMOS αντιστροφέα. 

 
 Παρατηρείται ότι, όταν η τάση της εισόδου ισούται με 0V, δηλαδή βρίσκεται 

στο λογικό 0, τότε το PMOS τρανζίστορ άγει, ενώ το NMOS τρανζίστορ δεν άγει, 

έχοντας ως αποτέλεσμα η τάση εξόδου του αντιστροφέα να ισούται με την τάση στην 

υποδοχή του PMOS, η οποία ισούται με 5V, δηλαδή λογικό 1. Κατ’ αντιστοιχία, όταν 

η τάση της εισόδου βρίσκεται στο λογικό 1, τότε το NMOS τρανζίστορ άγει, σε 

αντίθεση με το PMOS, με αποτέλεσμα η τάση εξόδου να ισούται με την τάση της 

πηγής του NMOS, δηλαδή λογικό 0. 

 

5.4.2.3 Λογικά κυκλώματα με χρήση τρανζίστορ εγκάρσιου πεδίου 
MOSFET 
 
 Τα τρανζίστορ MOSFET δύνανται, επιπλέον, να χρησιμοποιηθούν ως 

διακόπτες για την υλοποίηση λογικών κυκλωμάτων. Στην Εικόνα 76, διακρίνεται η 

διαγραμματική απεικόνιση ενός κυκλώματος μιας πύλης NOR με συνδεσμολογία 

pseudo-NMOS. 
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Εικόνα 76: Πύλη NOR σε λογική pseudo-NMOS. 

 

Με την κατασκευή της συνδεσμολογίας της Εικόνας 76 και πραγματο-

ποιώντας ακολούθως μια Transient ανάλυση, προκύπτει η γραφική παράσταση της 

Εικόνας 77, όπου απεικονίζεται η λειτουργία της πύλης NOR. 

 

 
Εικόνα 77: Λειτουργία της πύλης NOR. 

 
 
 Επόμενα, γίνεται κατανοητό ότι, το PMOS τρανζίστορ άγει σε κάθε 

περίπτωση. Όταν η είσοδος Α βρίσκεται σε λογικό 1 και η είσοδος Β σε λογικό 0, το 

 63



πρώτο NMOS τρανζίστορ άγει, ενώ το δεύτερο δεν άγει, έχοντας ως αποτέλεσμα η 

τάση εξόδου της πύλης να ισούται με την τάση στην πηγή του πρώτου NMOS, που 

ισούται με 0V, δηλαδή λογικό 0. Εν συνεχεία, η τάση της εισόδου Α πέφτει στο 

λογικό 0, ενώ και η τάση της εισόδου Β παραμένει σε λογικό 0, οπότε και κανένα 

NMOS τρανζίστορ δεν άγει και η έξοδος οδηγείται, από το PMOS, σε λογικό 1. Όταν 

η είσοδος Β ανέβει στο λογικό 1, τότε το αντίστοιχο NMOS άγει, κατεβάζοντας την 

έξοδο σε λογικό 0. Συμπερασματικά, το κύκλωμα της Εικόνας 76 υλοποιεί μια πύλη 

NOR ( Υ=(Α+Β)’ ). 
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